Microsoft Access 2007

Training Workbook

Created by the Office of Information Technologies and Digital Media
Technology Training Services
## Table of Contents

Overview ................................................................................................................................. 4

The Microsoft Access 2007 Ribbon ....................................................................................... 5

Section I .................................................................................................................................. 7

Learning Objectives ............................................................................................................. 7

Opening Microsoft Access 2007 ......................................................................................... 8

Designing a Database ............................................................................................................ 10
  Determining the Purpose of the Database ........................................................................ 10
  Determining the fields needed .......................................................................................... 11

Identifying the Access 2007 Interface and Icons ..................................................................... 13

Creating a Table in Datasheet View ..................................................................................... 14

Creating a Table in Design View ........................................................................................ 15

Data Types ............................................................................................................................ 15

Creating a Table in Design View ........................................................................................ 17

Field Properties .................................................................................................................... 18

Setting the Field Size Property ......................................................................................... 21

Setting a Required Field ..................................................................................................... 21

Setting an Input Mask for a field ....................................................................................... 22

Using Table Templates to Create Tables ........................................................................... 24

Defining the Primary Key ..................................................................................................... 24

Section II ................................................................................................................................ 26

Learning Objectives ............................................................................................................ 26

Filters ...................................................................................................................................... 26

  Applying a Filter ................................................................................................................ 26

  Removing All Filters for an Object .................................................................................. 28

Queries .................................................................................................................................... 29

  Creating a Query ............................................................................................................... 29

  Creating a Query using the Query Wizard .................................................................... 31

Forms ...................................................................................................................................... 34

  Create a Form Using the Form Tool .............................................................................. 34

  Create a Split Form Using the Split Form Tool ............................................................. 34

  Create a Form Using the Multiple Items Tool ............................................................... 35
Create a Form Using the Form Wizard.................................................................36
Create a Form Using the Blank Form Tool ....................................................37
Reports ............................................................................................................40
Create a Report Using the Report Tool ............................................................40
Create a Report Using the Report Wizard .........................................................40
Create a Report Using the Blank Report Tool ................................................42
Creating Mailing Labels in Microsoft Access 2007 ...........................................43
Microsoft Access 2007

Overview

Access 2007 has made a huge leap in design and technology for Access users. With this improved technology, we now have access to Automatic Data Type Detection, SharePoint Services Support, the ability to Save Reports to PDF, a Real-Time Report Wizard, Multi-Value and Attachment Fields, and the ability to access and use information from Multiple Data Sources.

Office Access 2007 also provides a new feature called the Navigation Pane. The pane replaces the Database window, and may be used instead of switchboards. Microsoft Access 2007 has a new user interface model, the Single-Document Interface Model. This model places open objects in a single window marked with a tab, providing easier access and greater efficiency in switching between objects.

Microsoft Access 2007 is a Database Management System used to organize large amounts of data. This includes, but is not limited to, addresses, names, grades, product inventory, etc. With Access 2007 you can create tables, create electronic forms, query data and print reports. These tools significantly decrease entry error. Certain objects in a database aid the user in managing their data.

1. **Table** - These are subject based lists that contain rows and columns, often described as the heart of the database. They will store all the information managed by the user.

2. **Query** - Simply put, when the user wants to change, review, delete or change data, he/she will use a query. A query can be used to filter, perform calculations on, or summarize data.

3. **Form** - Forms are used to enter, edit, and display data. Using forms, you can also control data access and display.

4. **Reports** - Reports range from simple to complex. You can print and preview data in attractive, professional formats.

5. **Macro** - This is a tool that will allow you to automate tasks. Macros add functionality to your forms, reports, and controls.

6. **Module** - Modules add functionality to your database. They are similar to macros, except they are written using visual basic programming. A module is a unit made up of a collection of declarations, statements, and procedures.
The Microsoft Access 2007 Ribbon

Home Tab

This tab gives you access to Views, Formatting tools, Records, Sort and Filter, and Find.

![Home Tab Screenshot]

The Create Tab

Using the Create tab, you can create and design Tables, Forms, Reports, Other queries and Macros.

![Create Tab Screenshot]

The External Data Tab

Here you can Import, Export, Collect Data, and manipulate SharePoint Lists.

![External Data Tab Screenshot]
**The Database Tools Tab**

The Database Tools tab allows you to Show/Hide, create Macros, Move Data and access Database Tools.

**The Datasheet Tab**

Under the Datasheet tab you have access to the Views group, Fields and Columns group, Data type and Formatting group, and the Relationship group.
Section I

Learning Objectives

- Opening Microsoft Access 2007
- Designing a Database
- Identifying the Access 2007 Interface and Icons
- Creating a Table in Datasheet View
- Creating a Table in Design View
- Using Table Templates to create Tables
- Defining the Primary Key
Opening Microsoft Access 2007

1. Click on **Start**, then **All Programs**, and under **Microsoft Office** click on **Microsoft Access 2007**.
2. The following screen will appear.

3. Here you can select a **New Blank Database**, or scroll to access **Featured Online Templates**.
4. To open a blank database, click on **Blank Database** and the following screen will appear.
5. Click on the folder icon to change the default location of the database, Type a Name for your database in the File Name field, then click on Create.
Designing a Database

A database that is designed well will provide you with access to accurate, up-to-date information. A database should meet your needs, as well as easily accommodate or adapt to change.

In order for your database to perform efficiently, you should ensure that the following steps are adhered to. When you have completed these steps, troubleshoot and refine.

1. Determine the purpose of the database.
2. Determine the tables that are needed in the database.
3. Determine the fields needed in the tables.
4. Identify fields with unique values in each record
5. Determine the relationships between tables

Determining the Purpose of the Database

Best practice is to make notes on paper. Write down the purpose of the database. Be specific in terms of how it will be used and who will be using it. This will make it easy to determine your tables, forms, fields, etc. You may need to refer back to these notes time and time again throughout the design process, so it is a good idea to start out with very good notes that will aid in decision making later on. Make notes on possible questions that the database should answer. Make a note of possible reports to be produced, and it doesn’t hurt to review a few existing databases.

Determining the tables that are needed

It is advisable to choose the major subjects as a starting point to determining the tables that are needed. For example this may include the Customers (their names, addresses, account number, email address), Manufacturers (Company name, address, region), Product (name, category, unit price, bulk price), and Order Information (agent, order number, date, price, quantity), etc. Again, it is always best practice to create the design on paper first. Note that the table should not contain duplicate information and each table should have information on only one subject. Before you start to create tables in Microsoft Office Access 2007, there are a few differences from earlier versions of Access that you should keep in mind. Table and field templates have replaced the Table Wizard. In earlier versions of Access, you used the
Table Wizard to create a table quickly by answering a few questions. In Office Access 2007, the Table Wizard has been replaced by table and field templates.

**Determining the fields needed**

While a table contains information about one subject, a field in a table contains individual facts about the table’s subject. For example, if the subject/table is Customer, the fields may be listed as Company Name, Address, Phone number, and Account Number. Keep the following rules in mind when determining your fields.

- Each field should be directly related to the subject of the table.
- Derived or calculated data should not be included.
- All the information needed must be included.
- Information should be stored in its smallest logical parts. That is, for example street address, city, state, zip, instead of just address.

![Table Example](image)

**Identifying the field/s with unique values in each record**

Each table must contain a field/s that uniquely identifies each record in the table. That is, a Primary Key. This will allow Access 2007 to connect information stored in different tables.
Determining the relationships between tables

Relationships between tables have to be identified. This tells Microsoft Access how to bring related back together to make it meaningful. Once the information has been divided into tables and primary key fields have been identified, you must then define the relationships between tables.

Troubleshooting and Refining

It is always best practice to review the design of your tables, fields and relationships after completion to check for any existing design flaws. This will prove less difficult now, than after data has been added.

MS Access should be used to create tables, specify relationships between the tables, and enter enough sample data in the tables so that the design may be tested. To test the relationships in a database, it is necessary to see if queries can be created to get the answers and results sought. Rough drafts of forms and reports should be created in order to confirm that the data expected is shown. Unnecessary duplications of data should be found and eliminated. If the user experiences problems, then the design should be refined.
Identifying the Access 2007 Interface and Icons

1. **Access Application Title Bar** - Identifies the Application Name and contains the application icon, Maximize, Restore, Minimize and Close buttons.

2. **Access 2007 Ribbon** - The Ribbon helps you to quickly find the commands needed to complete tasks. Each command is organized into related groups, collected together under tabs, whereas each tab relates to a specific type of activity.

3. **Views** - You will see your current view reflected here. That is, Datasheet View, PivotTable View, PivotChart View, or Design View.

4. **Navigation Pane** - The Navigation Pane has replaced the Database Window. The Navigation Pane is used to organize the objects in a database into categories and groups.
Creating a Table in Datasheet View

All the information that is stored within a database is stored in a table. There are 3 different ways to create tables in Access, depending upon your needs and/or your level of usage. One of the easiest ways is to create the table in Datasheet View.

Microsoft access 2007 automatically opens a blank database in Datasheet view.

1. Open Microsoft Access 2007 and open an existing or blank database.

2. In the **Add New Field** box, type the name of the field.

3. Use your **tab** key or the **arrow keys** on your keyboard to move to the next field and type a **name** for that field as well.

4. Repeat the previous step until you have typed all your required field names.

5. Repeat the previous step until you have typed all of your required field names.

6. Save the table by clicking on the **Save** button. You can also **right-click** on **Table** and the following menu will appear.

7. Click on **Save**. The box below will appear.
8. Type a **Table Name** for your table and click **OK**.

Creating a Table in Design View

The Table Design View can be used to modify a previously created table or to create a new table. The window is divided into two parts; the **Field Entry** area at the top half of the screen, and the **Field Properties** area at the bottom half of the screen.

![Table Design View](image.png)

**Data Types**

**Data Types** play an important role in database creation. These can be altered in Design view, as well as Datasheet view. There are 11 different types to choose from. The data type determines what kind of
information may be entered into a field. You can also change the data type of a field after you have entered data into it. The following table, provided by Microsoft, gives information on different data types.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Used to store</th>
<th>Limitations/Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Alphanumeric data (text and numbers)</td>
<td>Stores up to 255 characters.</td>
</tr>
<tr>
<td>Memo</td>
<td>Alphanumeric data (text and numbers)</td>
<td>Stores up to 2GB of data (the size limit for all Access databases), if you fill the field programmatically. Remember that adding 2GB of data causes your database to operate slowly. If you enter data manually, you can enter and view a maximum of 65,535 characters in the table field and in any controls that you bind to the field. When you create databases in the Office Access 2007 file format, Memo fields also support rich-text editing. For more information, see the articles Format data in tables, forms, and reports, Enter or edit data in a control or column that supports rich text and Insert, change, or delete a Memo field.</td>
</tr>
<tr>
<td>Number</td>
<td>Numeric data</td>
<td>Number fields use a <strong>Field Size</strong> setting that controls the size of the value that the field can contain. You can set the field size to 1, 2, 4, 8, or 16 bytes. For more information about Number fields, see the article Insert, create, or delete a field to store numeric values.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Dates and times</td>
<td>Access stores all dates as 8-byte double-precision integers. For more information about using Date/Time fields, see the article Insert, create, or delete a field that stores date values.</td>
</tr>
<tr>
<td>Currency</td>
<td>Monetary data</td>
<td>Stores data as 8-byte numbers with precision to four decimal places. Use this data type to store financial data and when you don't want Access to round values.</td>
</tr>
<tr>
<td>AutoNumber</td>
<td>Unique values created by Access when you create a new record</td>
<td>Stores data as 4-byte values; typically used in primary keys. For more information about primary keys, see the article Add, set, change or remove the primary key.</td>
</tr>
<tr>
<td>Yes/No</td>
<td>Boolean (true or false) data.</td>
<td>Access uses -1 for all Yes values and 0 for all No values.</td>
</tr>
<tr>
<td>OLE Object</td>
<td>Images, documents, graphs, and other objects from Office and Windows-based programs</td>
<td>Stores up to 2GB of data (the size limit for all Access databases). Remember that adding 2GB of data causes your database to operate slowly. OLE Object fields create bitmap images of the original document or other object, and then display that bitmap in the table fields and form or report controls in your database. For Access to render those images, you must have an OLE server (a program that supports that file type) registered on the computer that runs your database. If you don't have an OLE server registered for a given file type, Access displays a broken image icon. This is a known problem for some image types, most notably JPEG images. As a rule, you should use Attachment fields for your .accdb files instead of OLE Object fields. Attachment fields use storage space more efficiently and are not limited by a lack of registered OLE servers. For more information about using attachments, see the last row in this table, and see the</td>
</tr>
</tbody>
</table>
Attach files and graphics to the records in your database.

<table>
<thead>
<tr>
<th>Hyperlink</th>
<th>Web addresses</th>
<th>Stores up to 1 gigabyte of data. You can store links to Web sites, sites or files on an intranet or Local Area Network (LAN), and sites or files on your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Any supported type of file</td>
<td>New to Office Access 2007 .accdb files. You can attach images, spreadsheet files, documents, charts, and other types of supported files to the records in your database, much like you attach files to e-mail messages. You can also view and edit attached files, depending on how the database designer sets up the Attachment field. Attachment fields provide greater flexibility than OLE Object fields, and they use storage space more efficiently because they don’t create a bitmap image of the original file. For more information about using attachments, see the article Attach files and graphics to the records in your database.</td>
</tr>
<tr>
<td>Lookup Wizard</td>
<td>Data types are set based on values selected in the wizard.</td>
<td></td>
</tr>
</tbody>
</table>

**Creating a Table in Design View**

1. Under the Create tab, in the Tables group, click on Table.
2. Under the Home tab, in the Views group, click on the arrow below Views and select Design View.
3. The window will automatically change to Design View.
4. In the Field Name column, type the name of the first field in the table.
5. You can tab to the next field, or click in it and click on the arrow that appears.
6. Choose a Data Type for that field.
7. To accept the default entry, simply tab to, or click in the field for your next entry.
8. You can also type a description for your entry in the **Description** field.
9. If desired, press tab and type a description.

10. Set any additional **Field Properties** that you need to at the bottom of the page, for example field size, by clicking in that field. Here you can limit the number of characters users can enter, etc.

11. An arrow and drop down menu will appear. Make your selection.

12. Remember to save your changes by clicking on the **Save** button on your **Quick Access Toolbar** above your Access 2007 Ribbon.

### Field Properties

<table>
<thead>
<tr>
<th>Field Property</th>
<th>Data Type</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Size</td>
<td>Text</td>
<td>Set the maximum size for data stored as a <strong>Text</strong>, <strong>Number</strong>, or <strong>AutoNumber</strong> data type.</td>
</tr>
<tr>
<td></td>
<td>Number</td>
<td><strong>Note</strong>: For best performance, always specify the smallest sufficient <strong>Field Size</strong>. Text: Values from 1 to 255 characters. <strong>Number</strong> – Byte, Integer, Long Integer, Single, Double, Replication ID, Decimal. <strong>AutoNumber</strong> – Long Integer, Replication ID,</td>
</tr>
</tbody>
</table>
### Format

<table>
<thead>
<tr>
<th>Field</th>
<th>Text</th>
<th>Memo</th>
<th>Number</th>
<th>Date/Time</th>
<th>Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Customize the way that the field appears by default when it is displayed or printed.</td>
<td>Text</td>
<td>Number – General Number, Currency, Euro, Fixed, Standard, Percent, Scientific,</td>
<td>Date/Time – General Date, Long Date, Medium Date, Short Date, Long Time, Medium Time, Short Time.</td>
<td>Yes/No – True/False, Yes/No, On/Off.</td>
</tr>
</tbody>
</table>

### Decimal Places

<table>
<thead>
<tr>
<th>Field</th>
<th>Number, Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Specify the number of decimal places to use when displaying numbers.</td>
</tr>
</tbody>
</table>

### New Values

<table>
<thead>
<tr>
<th>Field</th>
<th>AutoNumber</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Set whether an AutoNumber field is incremented or assigned a random value when a new record is added.</td>
</tr>
</tbody>
</table>

### Input Mask

<table>
<thead>
<tr>
<th>Field</th>
<th>Text, Number, Date/Time, Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Display editing characters to guide data entry.</td>
</tr>
</tbody>
</table>

### Caption

<table>
<thead>
<tr>
<th>Field</th>
<th>All data types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Set the text displayed by default in labels for forms, reports, and queries.</td>
</tr>
</tbody>
</table>

### Default Value

<table>
<thead>
<tr>
<th>Field</th>
<th>Text, Memo, Number, Date/Time, Currency, Yes/No, Hyperlink</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Automatically assign the specified value to a field when a new record is added.</td>
</tr>
</tbody>
</table>

### Validation Rule

<table>
<thead>
<tr>
<th>Field</th>
<th>Text, Memo, Number, Date/Time, Currency, Yes/No, Hyperlink</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Supply an expression that must be true to add or change the value in this field.</td>
</tr>
</tbody>
</table>

### Validation Text

<table>
<thead>
<tr>
<th>Field</th>
<th>Text, Memo, Number, Date/Time, Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter text that appears when a value entered in this field violates the expression in the Validation Rule box.</td>
</tr>
<tr>
<td>Property</td>
<td>Data Types</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Required</td>
<td>All data types except AutoNumber</td>
</tr>
<tr>
<td>Allow Zero Length</td>
<td>Text, Memo, Hyperlink</td>
</tr>
<tr>
<td>Indexed</td>
<td>Text, Memo, Number, Date/Time, Currency, AutoNumber, Yes/No, Hyperlink</td>
</tr>
<tr>
<td>Unicode Compression</td>
<td>Text, Memo, Hyperlink</td>
</tr>
<tr>
<td>IME Mode</td>
<td>Text, Memo, Date/Time, Hyperlink</td>
</tr>
<tr>
<td>IME Sentence Mode</td>
<td>Text, Memo, Date/Time, Hyperlink</td>
</tr>
<tr>
<td>Smart Tags</td>
<td>Text, Memo, Number, Date/Time, Currency, AutoNumber, Hyperlink</td>
</tr>
<tr>
<td>Append Only</td>
<td>Memo, Hyperlink</td>
</tr>
<tr>
<td><em>Note that changing this property to No will erase field value history.</em></td>
<td></td>
</tr>
<tr>
<td>Text Format</td>
<td>Memo</td>
</tr>
</tbody>
</table>
### Setting the Field Size Property

1. Display the table in **Design View**.
2. Select the field whose property you want to change by clicking on it.
3. In the **Field Properties** section, select the current **Field Size** value.
4. Type a new field size value. Remember to **Save** your document as you make changes.

<table>
<thead>
<tr>
<th>General</th>
<th>Lookup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Size</td>
<td>100</td>
</tr>
<tr>
<td>Format</td>
<td></td>
</tr>
<tr>
<td>Input Mask</td>
<td></td>
</tr>
<tr>
<td>Caption</td>
<td></td>
</tr>
<tr>
<td>Default Value</td>
<td></td>
</tr>
<tr>
<td>Validation Rule</td>
<td></td>
</tr>
</tbody>
</table>

### Setting a Required Field

1. Display the table in **Design View**.
2. Select the field whose property you want to change.
3. In the **Field Properties** section, select the **Required** value.
4. Once you click on it, a drop down menu with the options **Yes** and **No** will appear.
5. Select **Yes**. Your change will take place immediately.

**Setting an Input Mask for a field**

1. Display the table in **Design view**.
2. Select the field whose property you want to change.
3. In the Field Properties section, select the Input Mask value.

4. Click the **Build Button** to the right of the field. The box below will appear, prompting you to save the table.

5. When you select **Yes**, the **Input Mask Wizard** will appear.
6. Click **Next** when you have made your selection.

7. Here you can make changes to your **Input Mask** and select a **Placeholder Character**.
8. Click **Finish**. **Save** your changes.
Using Table Templates to Create Tables

In previous versions of Microsoft Access, you had the option of using a table wizard to create a table. With Microsoft Access 2007, the process has been made even simpler as the wizard feature has been removed and is replaced with Table Templates.

1. Under the Create tab, in the Tables group, click on Table Templates.
2. A drop down menu will appear. Select a table template by clicking on it.
3. The template fields will automatically appear in your new table.
4. To gain access to other Access templates, click on the Office Button.
5. Click on New. You can then select a template under Featured Online Templates in the categories Assets, Contacts, Issues, Events, Marketing Projects, etc.

Defining the Primary Key

A primary key is a field or set of fields in your table that provide Microsoft Office Access 2007 with a unique identifier for every row. After you divide your information into separate, subject based tables, it is advisable to define table relationships and primary keys to tell Access how to bring the information back together again. The Primary Key field is used to quickly associate data from multiple tables and combine that data in a meaningful way. For example, ID numbers or Social Security numbers. Note that a Primary Key must not remain blank.
1. To set the primary key, you must use Design view.

2. If the database is not yet open, click on the **Microsoft Office Button**, and then click **Open**.

3. In the **Open** dialog box, select and open the database.

4. In the **Navigation Pane**, right-click the table in which you want to set the primary key.

5. On the shortcut menu that appears, click to select **Design View**.

6. Select the field/s you would like to use as the primary key.

7. To select one field, click the row selector for the field you want.

8. To select more than one field, hold down CTRL on your keyboard and then click the row selector for each field.

9. On the **Design** tab, in the **Tools** group, click **Primary Key**. Your Primary Key is now set.
Section II

Learning Objectives

Filters
- Adding a Filter
- Removing all Filters from an Object

Queries
- Creating a Query
- Creating a Query Using the Query Wizard

Forms
- Create a Form Using the Form Tool
- Create a Split Form Using the Split Form Tool
- Create a Form Using the Multiple Items Tool
- Create a Form Using the Form Wizard
- Create a Form Using the Blank Form Tool

Reports
- Create a Report Using the Report Tool
- Create a Report Using the Report Wizard
- Create a Report Using the Blank Report Tool

Creating Mailing Labels in Microsoft Access 2007

Filters

Filters are used to print specific records in a report, query, or table. They are also used to find one or more records in a form. The filter limits the display of data. They can be used to view a smaller range in a data list, rather than having to scroll through an entire list. In essence, it changes the data that a form or report displays in a view, without altering the design of the report or form.

Applying a Filter

1. Open a table, query, form, or report in Datasheet, Form, Report, or Layout View.
2. Make sure that the view is not already filtered.
3. Click anywhere in the column or control for the first field that you want to filter.
4. On the **Home** tab, in the **Sort & Filter** group, click **Filter**.

5. To apply a common filter, point to **Text Filters**, and then click the filter that you would like to apply. For example, **Contains**.

6. The following box will appear. Type the **Custom Filter** data and click **OK**.
7. If you have a large list of values, and if you want to filter on one or only a few of those values, first clear the **Select All** check box and then select the values you want.

8. To filter for null/blank values in text, number, and date fields, in the check box list, clear the **Select All** check box, and then select the check box next to **Blanks**.

9. To filter other data, repeat the steps above.

**Removing All Filters for an Object**

1. On the **Home** tab, in the **Sort & Filter** group, click **Advanced**.

2. Click **Clear All Filters**.
Queries

These are guidelines used to search database tables and retrieve records that meet specific conditions. You can use queries when you want to add, change or review data in your database. Queries answer specific questions, filter, and summarize data. They serve an automation purpose as well, in that you can automate data management tasks.

Creating a Query

1. Open your database.

2. On the Create tab, in the Other group, click on Query Design.

3. In the Show Table dialog box, on the Tables tab, double-click the table you want to run a query on.

4. Close the Show Table dialog box. The selected table will appear.
5. In the selected table, **double-click** fields to add to the query design grid (shown below).

6. On the **Design** tab, in the **Results** group, click on **Run**.

7. The query runs and then displays a list of your selected fields.
8. To save the query, click on the Save icon 📜. The following Save As box will appear.

9. Type a Query Name and click OK.

Creating a Query using the Query Wizard

The Query Wizard helps you create a Simple Query, a Crosstab Query, a Find Unmatched Query, or a Find Duplicates Query.

1. On the Create tab, under the Other group, click on the Query Wizard.
2. The **New Query** box will appear.

![New Query Wizard](image1.png)

3. Select the type of query you would like to run, for example Crosstab, and click **OK**.

4. Select the **table** you want to use by double clicking on it. Click **Next**.

![Crosstab Query Wizard](image2.png)

5. Select up to three field values to use as **Row Headings** and click **Next**.
6. Select the fields you would like to use as **Column Headings** and click **Next**.

7. Type a name for the query and **View** or **Modify**, and then click **Finish**.
Forms

Forms are database objects that can be used to edit, enter, or display data from a table or a query. There are five ways to create forms in Microsoft Access 2007. You can create a form using the Form Tool, the Split Form Tool, the Multiple Items Tool, the Form Wizard, and the Blank Form Tool.

Create a Form Using the Form Tool

1. In the Navigation Pane, select the table or query that you would like to use to create the form by clicking on it.
2. On the Create tab, in the Forms group, click on Form.
3. The form is automatically created using the data, and is displayed in Layout View.

Create a Split Form Using the Split Form Tool

The Split Form tool, a new Access feature, gives you two views of the data at the same time; a Form View and a Datasheet View.

1. In the Navigation Pane, select the table or query that you would like to use to create the form by clicking on it.
   Or
2. Open the table or query in Datasheet view.
3. On the Create tab, in the Forms group, click on Split Form.
4. The information will appear on a Split Form.
Create a Form Using the Multiple Items Tool

When you create a form by using the Simple Form tool, the form that Access creates displays a single record at a time. If you want a form that displays multiple records, but is more customizable than a datasheet, you can use the Multiple Items tool.

1. In the **Navigation Pane**, click the table or query that contains the data you want to see on your form.

2. On the **Create** tab, in the **Forms** group, click **Multiple Items**.

3. Access creates the form and displays it in **Layout View**.
Create a Form Using the Form Wizard

1. On the **Create** tab, in the **Forms** group, click **More Forms**, and then click on **Form Wizard**.

2. The **Form Wizard Box** will appear.
3. Select the **Table, Available Fields**, and click **Next**.

4. Select the **Layout** and click **Next**.

5. Select the **Form Style**, click **Next**.

6. Type a **Title** for your form and click **Finish**.

**Create a Form Using the Blank Form Tool**

If you plan to put only a few fields on your form, using the Blank Form tool is an easy way to go.

1. On the **Create** tab, in the **Forms** group, click on **Blank Form**.
2. A blank form will open in **Layout View**, displaying the **Field List** pane.

3. In the **Field List** pane, click the plus sign ➕ next to the table or tables that contain the fields that you want to see on the form.

4. To add a field to the form, double-click it or drag it onto the form. To add several fields at once, hold down the CTRL button on your keyboard and click several fields. You can then drag them onto the form at the same time.
5. On the **Format** tab, in the **Controls** group, click to add a Logo, Title, Page Numbers, or the Date and Time to the form.

6. To use more controls, change to **Design View**.

7. On the Design tab, in the **Controls** group, select the controls you would like to use by clicking on them.
Reports

A report is a summary of information pulled from tables or queries. It is information stored with the report design. The source of the data for reports is referred to as the **Record Source**.

Create a Report Using the Report Tool

1. In the **Navigation Pane**, select the table or query you want to base the report on.
2. On the **Create** tab, in the **Reports** group, click on **Report**.

![Report Tool]

3. The report will now be displayed in **Layout view**.
4. On opening the report in the future, it will display the most recent data gained from your **Record Source**.

Create a Report Using the Report Wizard

Using the report wizard you can select fields, specify data grouping and sorting, as well as use multiple data sources. You can use the Report Wizard to be more selective about what fields appear on your report.

1. On the **Create** tab, in the **Reports** group, click on the **Report Wizard**.

![Report Wizard]

2. The **Report Wizard** will appear.
3. Select the Tables/Queries you want to use, as well as the Available Fields and click Next.

4. Select Grouping Levels, if any, and click Next.

5. Select the Sorting Order and click Next.

6. Select the Layout, Style, and Title and click Finish.
Create a Report Using the Blank Report Tool


2. A blank report will be displayed in Layout view. The Field List pane is displayed on the right.

3. In the Field List pane, click the plus sign next to the table or tables that contain the fields that you want to see on the form.

4. To add a field to the form, double-click it or drag it onto the form. To add several fields at once, hold down the CTRL button on your keyboard and click several fields. You can then drag them onto the form at the same time.

5. On the Format tab, in the Controls group, click to add a Logo, Title, Page Numbers, or the Date and Time to the form.
Creating Mailing Labels in Microsoft Access 2007

Labels are commonly used in Access for mailing, but can be used for other purposes as well. In Access, all data can be printed in label format. To create a label in Access 2007, the report gets the address data from the tables or queries containing the addresses. When printing the report, a single label is printed for each address from the record source.

Create Labels Using the Label Wizard

1. In the Navigation Pane, select/open the record source for your labels (table or query).
2. On the Create tab, in the Reports group, click Labels.
3. The Label Wizard will appear.
4. Choose the Manufacturer and Label Size, and then click Next.
5. Choose the **Font Name**, **Font Size**, **Font Weight**, and **Text Color**.

6. Select the **Available Fields** to be placed on your label. Double-click to add them to the **Prototype Label** box and click **Next**.
### Prototype Label Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spaces</td>
<td>Press SPACEBAR</td>
</tr>
<tr>
<td>New Line</td>
<td>Press Enter</td>
</tr>
<tr>
<td>Move Between Fields And Lines</td>
<td>Use Arrow Keys</td>
</tr>
<tr>
<td>Remove a Field</td>
<td>Press BACKSPACE</td>
</tr>
<tr>
<td>Add other text or punctuation</td>
<td>Place Cursor and type</td>
</tr>
</tbody>
</table>

7. Choose fields to use to sort your labels and double-click them to add to the **Sort by** box. When you are finished, click **Next**.

8. Enter a name for your labels, and click **Finish**.

9. Your labels will be displayed.
<table>
<thead>
<tr>
<th>Name</th>
<th>Location</th>
<th>USA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andrew Crouch</td>
<td>Bellevue, 98005</td>
<td>USA</td>
</tr>
<tr>
<td>Nancy Friedrich</td>
<td>Seattle, 98109</td>
<td>USA</td>
</tr>
<tr>
<td>Lisa Goodale</td>
<td>Redmond, 98052</td>
<td>USA</td>
</tr>
<tr>
<td>Anne Hellard-Jamieson</td>
<td>Seattle, 98109</td>
<td>USA</td>
</tr>
<tr>
<td>Jan Kotarski</td>
<td>Redmond, 98052</td>
<td>USA</td>
</tr>
<tr>
<td>Michael Netzer</td>
<td>Redmond, 98052</td>
<td>USA</td>
</tr>
<tr>
<td>Maria Sanchez</td>
<td>Kirkland, 98033</td>
<td>USA</td>
</tr>
<tr>
<td>Steven Thorne</td>
<td>Seattle, 98109</td>
<td>USA</td>
</tr>
<tr>
<td>Kevin Zara</td>
<td>Seattle, 98109</td>
<td>USA</td>
</tr>
</tbody>
</table>